Sage Estimating

(formerly Sage Timberline Office Estimating)

Getting Started With Buyout
Table of Contents

Getting Started With Buyout

Section 1
Welcome to Buyout ................................................................. 1

About This Booklet ................................................................. 1
Ways to Get Help ................................................................. 2
Contact Customer Support ..................................................... 4

Section 2
Some Basic Concepts ............................................................. 9

The Buyout Process ............................................................... 9
The Buyout Workflow ........................................................... 10
The Items Window ............................................................... 11
The Worksheet Window ......................................................... 13

Section 3
Set Up a New Project in Buyout ............................................. 15

Create a New Database ......................................................... 15
Create a New Work File ......................................................... 17
Import an Estimate Into a Work File ...................................... 19

Section 4
Create and Send Quote Sheets .............................................. 21

Create a Quote Summary ..................................................... 21
Assign Items to a Quote Summary ......................................... 22
Add a Vendor to a Quote Summary ................................................................. 23
Send Quote Sheets ....................................................................................... 24

Section 5
Enter Vendor Prices, Analyze Quotes, and
Issue Purchase Orders .................................................................................. 27

Enter Vendor Prices ....................................................................................... 27
Compare and Analyze Quotes .......................................................................... 29
Select Vendors .................................................................................................. 29
Issue Purchase Orders ....................................................................................... 31

Appendix
Glossary ............................................................................................................. 33
Welcome to Buyout. Sage is pleased to welcome you as a client. Read this booklet to find out how Buyout can help you accelerate your next buy out.

Buyout saves time and reduces effort by automating the bid solicitation and selection process. You can quickly and accurately turn detailed estimates into a set of purchase orders and subcontracts so you can buy out the material and subcontract items for a project.

About This Booklet

This booklet covers the following topics:

- Welcome to Buyout—a discussion of the Help system and useful contact information.
- Some Basic Concepts—the concepts and philosophy behind Buyout.
- Set Up a New Project in Buyout—step-by-step instructions for setting up a new project.
- Create and Send Quote Sheets—step-by-step instructions for the tasks you commonly perform during the buyout process.
- Enter Vendor Prices, Analyze Quotes, and Issue Purchase Orders—step-by-step instructions to complete your Buyout workflow.
- Glossary—a list of terms and definitions related to Buyout.
Ways to Get Help

Buyout provides all the help you need—right on your computer.

- The Help system
- Training information
- Contact Sage Timberline Office Customer Support

The Help System

Buyout’s efficient Help system provides faster access to more information than most manuals. With a click of the mouse or a keystroke, you can easily get Help for a command, a field, a window, or a procedure.

To Get Help on a Window Option

Help is available on virtually every option within a window. To access it, do one of the following:

- Click [What’s This?] on the toolbar or [?] on the title bar and then click the option.
- Select What’s This from the Help menu and then click the option.
- Select the option and press [F1].
- **To Get Help for the Whole Window**
  For information about the window, such as the window's purpose and what tasks you can perform in it, click [Help] at the bottom of the window.

- **To Use Help to Learn How to Do Tasks**

  1. Click [Help] on the toolbar or select Help Topics from the Help menu.
2 Use the navigation pane to find a topic. The three tabs let you choose how you want to look for a topic.

- **Contents** contains Help subjects organized within books.
- **Index** contains an alphabetical list of Help subjects.
- **Search** looks through every word in Help to find matches for your search query.

When you see the topic you want, double-click it to display it in the topic pane.

3 Use the buttons on the toolbar to:

- Open and close the navigation pane.
- Move back and forth between topics you have already read.
- Change the size of the font.
- Print the current topic.
- Display a menu of useful options.

**Training Information**

Learn about the Anytime Learning and Realtime Learning sessions that are available, view schedules of online sessions, or look for classroom training near you.

You can directly access Sage University from the Help menu in applications (Help > Sage Timberline Office on the Web > Sage Software University). This website offers a variety of professional product training options.

**Contact Customer Support**

Depending on your Sage Service Plan, you may be able to take advantage of the following services:

**Sage Customer Portal**

You may log on to the Sage Customer Portal at https://customers.sagenorthamerica.com/irj/portal/anonymous/login to access any of the following services:

- **Knowledgebase**: Find answers to your questions, access downloads, and subscribe to your favorite articles. This service is available online 24/7.
- **Live Chat**: Chat online with a customer support analyst - a great option for quick questions. Chat hours are the same as our telephone support hours (see below).

- **Online Support Request**: Submit an online support ticket when you have a non-urgent question. One of our call center support analysts will assist you. Online support hours are the same as our customer support call center hours (see below).

**Sage Customer Support Call Center**

**Telephone Support**: When you have a more urgent question or would prefer to speak to a customer support analyst directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following exceptions:

- Every Thursday from 2 p.m. to 3 p.m. Pacific Time (closed for customer support staff meetings)
- Standard United States holidays
- Quarterly company meetings

**Upgrading Your Service Plan**

If your service plan does not provide online or telephone customer support and you would like to add or upgrade a service plan, please call 800-858-7098.
The Buyout Process

Buyout helps you tackle one of the toughest challenges facing project managers, estimators, and purchasing agents: to quickly and accurately turn a complex estimate into a set of purchase orders and subcontracts.

Buyout uses estimates from Estimating to create work files that allow you to group materials into quote summaries. Since Buyout links to Address Book, you can directly add vendors to the quote summaries and then send requests for quotes. Once you have received quotes from the vendors, you can select the preferred vendors and issue purchase orders or commitments directly to Job Cost or Purchasing.
The Buyout Workflow

Although each estimator, project manager, purchasing agent, and facility manager has a different way of doing things, the buyout process typically involves the following steps:

- **Create a Work File**: Import a Timberline estimate into Buyout to create a new work file.
- **Add Items to Quote Summaries**: Organize estimate items into logical groupings called quote summaries.
- **Add Vendors to Quote Summaries**: Add to the quote summaries the vendors or subcontractors that you will request quotes from.
- **Send Quote Sheets**: Send quote sheets to vendors or subcontractors to request prices. You can print, fax, or e-mail quote sheets.
- **Enter Vendor Prices**: Enter item prices or lump sum amounts in the quote sheets.
- **Select Vendors**: Compare quotes and select the preferred vendors.
- **Issue Purchase Orders**: Issue purchase orders to the selected vendors.
- **Analyze the Project**: Compare estimated costs to actual costs and determine the cost to complete the project.
- **Export Commitments**: Export commitments to Timberline accounting.
The Items Window

Buyout provides multiple ways to display items in the items grid so you can view them in the order that works best for you.

In the items grid (top pane), you can review the items to buy out for the current project and assign them to quote summaries.

In the detail pane (bottom pane), you can view and change information for individual items. The detail pane is similar to the Detail window in Estimating.
## Items Window Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Totals Icon]</td>
<td>Totals</td>
<td>Display the work file totals.</td>
</tr>
<tr>
<td>![Display Item Detail Pane Icon]</td>
<td>Display Item Detail Pane</td>
<td>Display item details.</td>
</tr>
<tr>
<td>![Show Worksheet Window Icon]</td>
<td>Show Worksheet Window</td>
<td>Display the <strong>Worksheet</strong> window.</td>
</tr>
<tr>
<td>![Sort Selector Icon]</td>
<td>Sort Selector</td>
<td>Select the sort sequence.</td>
</tr>
<tr>
<td>![Filter Selector Icon]</td>
<td>Filter Selector</td>
<td>Select the item filter.</td>
</tr>
<tr>
<td>![Unassigned Only Icon]</td>
<td>Unassigned Only</td>
<td>Display only the items not assigned to a quote summary.</td>
</tr>
<tr>
<td>![One-Time Item Icon]</td>
<td>One-Time Item</td>
<td>Create a one-time item.</td>
</tr>
<tr>
<td>![Assign Items Icon]</td>
<td>Assign Items</td>
<td>Assign items to a quote summary.</td>
</tr>
<tr>
<td>![Combine Icon]</td>
<td>Combine</td>
<td>Combine matching items.</td>
</tr>
<tr>
<td>![What's This? Icon]</td>
<td>What's This?</td>
<td>Display Help for a button, command, or window when you click it.</td>
</tr>
<tr>
<td>![Help Icon]</td>
<td>Help</td>
<td>Display Buyout Help.</td>
</tr>
</tbody>
</table>

**NOTE:** In this booklet, instructions that include these commands often include a picture of the icon as well.
The Worksheet Window

The Worksheet window provides the information you need to analyze and control the buyout process. From here you can monitor multiple quote summaries, gauge your progress in buying out the project, and reduce risk.

The worksheet grid (top pane) lays out the quote summaries for the current project in a familiar spreadsheet format. In the worksheet grid, you can add vendors or subs to quote summaries, send quote sheets, and issue purchase orders.

The Quote Summary pane (bottom pane) shows the quote summary currently selected in the worksheet grid. In the Quote Summary pane, you can enter amounts from vendor quotes, analyze incoming quotes and compare them side-by-side, and select the vendors to use.

Buyout always sorts vendors from lowest to highest, left to right, by their total bids in the Quote Summary pane.
### Worksheet Window Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Icon" alt="Totals" /></td>
<td>Totals</td>
<td>Display the work file totals.</td>
</tr>
<tr>
<td><img src="Icon" alt="Display Quote Summary Pane" /></td>
<td>Display Quote Summary Pane</td>
<td>Display the <strong>Quote Summary</strong> pane.</td>
</tr>
<tr>
<td><img src="Icon" alt="Show Items Window" /></td>
<td>Show Items Window</td>
<td>Display the <strong>Items</strong> window.</td>
</tr>
<tr>
<td><img src="Icon" alt="Sort Selector" /></td>
<td>Sort Selector</td>
<td>Sort the <strong>Worksheet</strong> window.</td>
</tr>
<tr>
<td><img src="Icon" alt="New Quote Summary" /></td>
<td>New Quote Summary</td>
<td>Create a new quote summary.</td>
</tr>
<tr>
<td><img src="Icon" alt="Add Vendor" /></td>
<td>Add Vendor</td>
<td>Add a vendor to a quote summary.</td>
</tr>
<tr>
<td><img src="Icon" alt="Send Quotes" /></td>
<td>Send Quotes</td>
<td>Send quotes to vendors.</td>
</tr>
<tr>
<td><img src="Icon" alt="Issue Purchase Order" /></td>
<td>Issue Purchase Order</td>
<td>Issue a purchase order.</td>
</tr>
<tr>
<td><img src="Icon" alt="Export Commitments" /></td>
<td>Export Commitments</td>
<td>Send commitments to Job Cost or Purchasing.</td>
</tr>
<tr>
<td><img src="Icon" alt="What’s This?" /></td>
<td>What’s This?</td>
<td>Display Help for a button, command, or window when you click it.</td>
</tr>
<tr>
<td><img src="Icon" alt="Help" /></td>
<td>Help</td>
<td>Display Buyout Help.</td>
</tr>
</tbody>
</table>

**NOTE:** In this booklet, instructions that include these commands often include a picture of the icon as well.
Create a New Database

A Buyout database (bos.dat) stores general, company folder, Job Cost setup, tax setup, and standard pricing information that specifies how you plan to use Buyout.

To Create a New Database

1. From the Database menu, select New Database.

Menu path—Database > New Database

2. Enter a folder name or click [Browse] to specify where you want the new database.
3 (Optional) Specify the location of the Estimating database (pei.dat) containing the data and other settings (including Job Cost setup information, Address Book location, and phases and units of measure to use for one-time items and standard prices) to use in Buyout.

4 Click [OK]. The Database Settings window opens.

Menu path—Database > Database Settings

5 Complete the options in the window to finish setting up your database. Click each tab to make sure you view all the database options.
Create a New Work File

Each work file (.bow) stores the items, vendor quote information, and totals for a specific Buyout project or job. Think of it as a folder that contains all the details for buying out a project.

To Create a New Work File


Menu path—File > New Work File

2. Enter a name (up to 100 characters) for the work file.

3. Enter a folder name or click [Browse] to specify where you want the new work file created.

4. Enter a folder name or click [Browse] to specify the Buyout database to use when creating the new work file.
5 Click [OK]. The **Import Estimates to Buyout Work File** window opens.

![Import Estimates to Buyout Work File window]

6 In the **Available estimates** list, select the estimates you want to import and click [Add >>]. The selected estimates appear in the **Estimates to import** list.

7 Complete the import options. Click [Details] to review your pricing options.

8 Click [OK] to import estimates into the new work file.

**NOTE:** You can also set work file options and view reference information for a work file in the **Work File Information** window, which is available from the **Actions** menu.
Import an Estimate Into a Work File

After you create a work file, you may find that you want to add one or more estimates to it. Use this procedure to import additional estimates into the current work file.

To Import Estimates Into a Work File

1. From the Interface menu, select Import Estimates. The Import Estimates to Buyout Work File window opens.

   Menu path—Interface > Import Estimates to Buyout Work File

2. Enter the full path of the folder containing the estimates you want to import into the current work file. You can also click [Browse] to select a different drive and folder.

3. In the Available estimates list, select the estimates to import.

4. Click [Add >>] to add the selected estimates to the Estimates to import list.

5. Select the desired import options, if any.

6. Click [OK] to import the estimates.
Create a Quote Summary

You can create quote summaries from the Worksheet or the Items window. A quote summary is a table of estimate items with quantities and amounts from Estimating and quotes from vendors who are bidding to supply those items.

To Create a Quote Summary From the Worksheet


   ![New Quote Summary Window]

2. Enter a unique name (up to 70 characters) for the quote summary.

3. Select a category (Material or Subcontract) for the quote summary.

4. Click [OK] to create the quote summary. Now you can assign items to the quote summary.
Assign Items to a Quote Summary

In the Items window, you can assign items to a quote summary at the same time you create it. You can mark the items that you want grouped together on a quote sheet by assigning them to quote summaries.

To Assign Items to a Quote Summary

1. In the Items window, select one or more items you want to assign to the quote summary.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One item</td>
<td>Click on any cell in the item row.</td>
</tr>
<tr>
<td>Consecutive items</td>
<td>Click on the first item and press SHIFT while you click the last item.</td>
</tr>
<tr>
<td>Scattered items</td>
<td>Press CTRL while you click each item.</td>
</tr>
</tbody>
</table>

2. Click [Assign Items] on the toolbar and enter a unique name (up to 70 characters) to create a new quote summary. Click [OK].

Menu path—Actions > Assign Items

![Assign Items - Material dialog box](image)

NOTE: You can add a one-time item if you need to include an item that was not in the source estimate or estimates. A one-time item is included in only a Buyout work file and does not originate from a record in an Estimating database. The One-Time Item command is available from the Actions menu or from [One-Time Item] on the toolbar.
Add a Vendor to a Quote Summary

Adding vendors and subcontractors to quote summaries determines which vendors and subs will receive your request quotes for quotes. It also allows you to compare their quotes side-by-side in the Quote Summary pane.

To Add a Vendor to a Quote Summary

1. In the worksheet, select the desired quote summary.
2. Right-click and select Add Vendor from the shortcut menu.
3. The Contact Selection List window opens a list of the vendors set up in Address Book.

Menu path—Actions > Add Vendor

4. Select one or more vendors in the list, and click [OK] to add them to the quote summary.

NOTE: If you need a vendor that is not in the list, you can set up the vendor as a one-time vendor in Buyout or add the vendor to Address Book. A one-time vendor is a vendor that you want to include in a Buyout work file but not in Address Book. These may be new or unknown vendors who provide unsolicited quotes for a job.
Send Quote Sheets

You can send quote sheets from the worksheet or the Quote Summary pane. You have the option to print a hard copy of the quote sheet, fax the quote sheet, or e-mail the quote sheet.

To Send Quote Sheets

1 Select the quote sheets to send.
   In the worksheet:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One quote sheet.</td>
<td>Click anywhere in the quote sheet row.</td>
</tr>
<tr>
<td>Consecutive quote sheets.</td>
<td>Click anywhere in the first quote sheet row and press SHIFT while you click on the last quote sheet row.</td>
</tr>
<tr>
<td>Scattered quote sheets.</td>
<td>Press CTRL while you click anywhere on each quote sheet row.</td>
</tr>
<tr>
<td>All the quote sheets in a quote summary.</td>
<td>Click anywhere in the quote summary row.</td>
</tr>
</tbody>
</table>

In the Quote Summary pane:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One quote sheet.</td>
<td>Click anywhere in the quote sheet column.</td>
</tr>
<tr>
<td>Consecutive quote sheets.</td>
<td>Click anywhere in the first quote sheet and press SHIFT while you click the column heading of the last quote sheet.</td>
</tr>
<tr>
<td>Scattered quote sheets.</td>
<td>Press CTRL while you click each quote sheet column heading.</td>
</tr>
</tbody>
</table>
2 Click [Send Quotes] on the toolbar. The Send Quotes window opens. The selected quote sheets appear in the quote grid.

Menu path—Actions > Send Quotes

3 On the Quotes tab, review the output options for each quote sheet and change them as needed.

4 On the other tabs, review the options for sending and formatting the quote sheets. Change the options as needed.

5 (Optional) Click [Preview] to preview the quote sheets before sending them.

6 Click [Send] to send the quote sheets.

NOTE: The Send Quotes command is also available on the Actions menu. Right-click to view the shortcut menu.
Section 5
Enter Vendor Prices, Analyze Quotes, and Issue Purchase Orders

Enter Vendor Prices

When you receive prices from vendors, you enter them in the vendor quote sheet.

You can also enter lump amounts for individual items in the Worksheet, Quote Summary pane, or Quote Sheet window. You can also enter a lump amount and Buyout will back calculate the amount for the items in the quote sheet.
To Enter Vendor or Sub Prices

1. Open the desired quote sheet.

   a. Select the desired quote sheet in the worksheet or Quote Summary pane.

   b. Right-click and select Open Quote from the shortcut menu. The Quote Sheet window opens.

2. Enter the item prices in the Price column. Click [OK].

3. To display the next quote sheet in this quote summary, click [>>]. To display the previous quote sheet in this quote summary, click [<<].

4. When you finish entering prices, click [Close].
**Compare and Analyze Quotes**

You can analyze incoming quotes and compare them side-by-side in the Quote Summary pane. Buyout always sorts vendors from lowest to highest, left to right, by their total bids. Totals appear in the bottom row of the Quote Summary pane.

Buyout also provides the Vendor Quote Comparison report to help you compare and analyze vendor quotes. Like the Quote Summary pane, this report allows you to compare vendor quotes against each other and against the budgeted (estimated) amount. Vendor quotes print side-by-side, from lowest to highest total, left to right.

When you finish reviewing the vendor quotes, you can select the preferred vendor in the worksheet or the Quote Summary pane.

**Select Vendors**

Use this procedure to choose the vendor or sub from whom you will purchase materials or subcontract services. When you select a vendor or sub, Buyout changes the status of the vendor quote sheet to Selected and a yellow star appears next to the vendor name in the worksheet and the Quote Summary pane.
To Select a Vendor or Sub

1. Locate the desired vendor or subcontractor in the worksheet.

2. Right-click the vendor name in the **Vendor/Sub** column, and choose **Select Vendor** from the shortcut menu.

**NOTE:** To select a vendor or subcontractor in the **Quote Summary** pane, right-click the vendor column heading and choose **Select Vendor** from the shortcut menu.
Issue Purchase Orders

You can issue purchase orders from the worksheet or the Quote Summary pane.

➢ To Issue a Purchase Order

1. Select the quote sheets for which to issue purchase orders.

   In the worksheet:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One quote sheet.</td>
<td>Click anywhere in the quote sheet row.</td>
</tr>
<tr>
<td>Consecutive quote sheets.</td>
<td>Click anywhere in the first quote sheet row and press SHIFT while you click on the last quote sheet row.</td>
</tr>
<tr>
<td>Scattered quote sheets.</td>
<td>Press CTRL while you click anywhere on each quote sheet row.</td>
</tr>
<tr>
<td>All the quote sheets in a quote summary.</td>
<td>Click anywhere in the quote summary row.</td>
</tr>
</tbody>
</table>

   In the Quote Summary pane:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>One quote sheet.</td>
<td>Click anywhere in the quote sheet column.</td>
</tr>
<tr>
<td>Consecutive quote sheets.</td>
<td>Click the column heading of the first quote sheet and press SHIFT while you click the column heading of the last quote sheet.</td>
</tr>
<tr>
<td>Scattered quote sheets.</td>
<td>Press CTRL while you click each quote sheet column heading.</td>
</tr>
</tbody>
</table>
2 Click [Issue Purchase Orders] on the toolbar. The Issue Purchase Order window opens. The selected quote sheets appear in the quote grid.

Menu path—Actions > Issue Purchase Order

3 On the Quotes tab, review the output options for each quote sheet which you are issuing a purchase order against and change the options as needed.

4 On the other tabs, review the options for creating and formatting the purchase orders. Change the options as needed.

5 (Optional) Click [Preview] to preview the purchase orders before issuing them.

6 Click [Issue] to issue the purchase orders. Buyout changes the status of the selected quote sheets to Issued.

NOTE: The Issue Purchase Orders command is also available on the Actions menu and from the shortcut menu.
Address Book
The application used to manage vendors, subcontractors, and contacts.

Buyout
1) The process used to solicit pricing and purchase materials and subcontractor services.
2) The application used to solicit prices for various materials and services and issue purchase orders for those materials and services.

commitment
An authorization to allocate funds to a project for materials or services.

contact
An entry in Address Book that contains the information you need to communicate with a particular individual or business. Contact entries typically include individual or company name, street address, phone number, e-mail address, and any other information relevant to the contact.

contact selection list
The Contact Selection List window is a list of the vendors set up in Address Book.

Detail pane
The pane located below the Items window. This pane displays detailed information about the item currently selected in the Items window.
item
An item is a particular material or service that Buyout prices and purchases. When you use Estimating with Buyout, only the items with material or subcontract costs are available in Buyout.

Items grid
The items grid is located in the Items window. It contains all the items from the estimates you imported into the work file.

lump amount
On a Buyout quote, a lump amount is a value that represents a vendor's calculated bid (quantity multiplied by unit price) for one item or for all items.

material class
A unique name for a set of material items that share a common characteristic. Material classes group together similar material items on quote summaries in Buyout. Example: Conc: Concrete Prod, Masonry: Brick.

one-time item
A one-time item is an item that was not in the source estimate or estimates. It is an item you include in a Buyout work file without creating a record in a Estimating database.

one-time vendor
A vendor that you want to include in a Buyout work file but not in Address Book. This may be a vendor that you receive quotes from, but do not wish to add to Address Book because you will not be buying from them.

piece count
The quantity of an item in the unit sold by the vendor. The piece count appears on purchase orders if you choose to include it.

primary estimate
The first estimate imported into a work file.

purchase order (PO)
A written commitment to a vendor to purchase materials or services from that vendor.
quote sheet
A quote sheet is a request for a quote (bid) to supply the specified materials or perform the specified work.

quote summary
A table of estimate items with quantities and amounts from Estimating and quotes from vendors who bid to supply those items.

request for quote (RFQ)
A request for a quote (bid) to supply the specified materials or perform the specified work.

standard price
The item price previously specified by a vendor. You can save standard prices by vendor for use on subsequent quote summaries.

subcontract
A written commitment to a subcontractor to acquire services from that subcontractor.

vendor
1) A supplier of materials or services. 2) A secondary contractor who performs some part of the prime contractor’s obligation under the contract.

work file
The file that stores the items, vendor quote information, and totals for a specific Buyout project or job. This file contains all the details for buying out a job.

worksheet
A spreadsheet containing all the quote summaries and quotes for the current work file. The worksheet shows the vendors, prices, and status associated with each quote summary.